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How to use Reason v2.5 with the I-CubeX
 
 
INTRODUCTION 
 

This document explains the various possiblities that exists to the end-user when working with the 
I-CubeX and Propellerheads' Reason software.  

 
PRODUCT 
 

Propellerheads' Reason software is offering a bundle which includes virtual synthesizers, 
samplers, drum machine, ReCycle-based loop player, mixer, effects, pattern sequencer, etc…  

 
INTERACTING WITH I-CUBEX 
 

Combined with the Reason software, the I-CubeX Digitizer offers a wider range of possiblity that 
can be explored. In this document, we show you several examples of their combined use and 
invite you to some new avenues. 
 

Before you start building a specific setup with Reason, you must have some idea of what you 
want to do. But before you do so, we provide here a several simple step by step examples of 
what can be done with Reason and the I-CubeX Digitizer just to get you started. 

 
We assume that you already have some understanding of both products. 

 
 
PROPELLERHEAD REASON V2.5 FOR WINDOWS  
 

In order to have a good understanding of all the capabilities of Reason software, the end user 
must be prepared to go through a fairly exhautive process. The way Reason handles incoming 
MIDI data is no exception to this. We will try to cover most aspects of it while keeping in mind that 
some detailed in-depth exploration will be left to you. 
 
 
Reason has basically seven MIDI inputs that can receive any standard MIDI messages from any 
MIDI ports. These inputs are assigned as follows: 
 

Nbr of MIDI Inputs Assigned to 
 
1  Sequencer 
4   External Control Bus 
1   Remote MIDI Control 
1   MIDI Clock 

 
To some of you, this information might sound a bit dry and too abstract. Do not worry, we will get 
through the significance of all this. (If you wish, you can also read in Propellerhead Reason 
software operation manual; the chapter is intitled “Routing MIDI to Reason”). Roughly, the 
sequencer allows the user to record incoming MIDI data to a track which can be played back 
afterwards. The external control bus permits a musician or creator to use an external device to 
play on a specific Reason device (such as Substrator (polyphonic synthetizer), ReDrum (drum 
machine), etc…). While the remote MIDI control handles incoming MIDI data to be sent to a 
specific on screen control such a virtual knob, slider or switch in order to control it. Finally, the 
MIDI clock set synchronization between two or more MIDI devices. 
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CONFIGURING INCOMING MIDI WITH REASON SOFTWARE 
 
 

Before we start going into the heart of the matter, we will start by going through the nuts and bolts 
of configuring incoming MIDI in Propellerhead Reason. 
 
All MIDI Inputs are set up in the Preferences-MIDI and Preferences-Advanced MIDI dialogs. 
Choose from the Edit menu “Preferences…” (see figure 1). The “Preferences” dialog pops up. 
Select from the drop down list the MIDI option as shown in figure 2. 
 
 

 
 

figure 1 

 
 

figure 2 
 
 
 
 
This MIDI option from the drop down list simply permits the user to select is incoming MIDI data port and 
is channel number associated with the standard MIDI message. It is used for assigning a MIDI port to the 
equencer of Reason (see figure 3) s

 
 

 
 

figure 3 
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The Advanced MIDI option from the drop down list combines more elements (figure 4). 
 
 

 
 

figure 4 
 
Select the MIDI port accordingly. Each drop down list should include all the of the MIDI ports 
available on the computer. You might have to come back to this dialog from time to time 
depending on what you are going to do with Reason software. 

 
CONFIGURING MIDI FOR THE I-CUBEX EDITOR/DIGITIZER 
 
 

Start the I-CubeX editor and set the Midi settings. Make sure that your digitizer is connected to 
the MIDI interface (see figure 5 and 6). Close your I-CubeX application.  
 
Nota Bene: Both applications cannot run together; only one at the time. 

 

 
figure 5 

 

 
figure 6 
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PLAYING WITH REASON SEQUENCER AND THE I-CUBEX DIGITIZER/EDITOR 
 
 
Assuming that you have properly connected your MIDI port to the Reason software as described 
previously and your Audio card in the “Preferences…” menu (see Reason documentation), we 
can now start playing around with the two combined technologies.  
 
 
REASON SEQUENCER AND I-CUBEX 
We invite you to go through the Propellerhead Reason “Getting Started” document. In chapter 3 
“Quick Tutorial”, there is a section intitled “Creating a new song”. Please follow the steps from 1 
to 6. We use this as a working ground for the rest of this section.  
 
STEP 1 
Inside your Reason software, you should have now installed on your virtual rack a mixer (14:2), 
Subtractor Analog synthetizer and a Redrum Drum Computer. The bottom window has the  
sequencer with the two described devices as shown in figure 7. 
 
Notice that the Redrum 1 has to the left some kind of small circle with black dots. It is actually a 
standard MIDI connector. It is indicating that the Redrum is set to receive incoming MIDI data.  
 
 

 
 

figure 7 
 

STEP 2 
Now, with the use of your mouse, you will click in the blank area of the Subtractor 1 row in the 
sequencer window (see figure 8). This will result in what is shown in figure 9. It is basically moves 
your MIDI connector indicator to the Subtrator Analog synthetizer. This operation forces your 
incoming MIDI data to go to the Subtractor. 

 
 

 
figure 8 

 
figure 9 
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STEP 3 
Save your setup and exit the Reason application.  
 
STEP 4 
Start your I-CubeX editor. We assume that you properly connected your Digitizer to the MIDI port.   
 
STEP 5 
From the File menu of the I-CubeX editor, select New so that the Digitizer is properly resetted.  
 
STEP 6 
From the Configure menu, select Add sensor in order to create a virtual sensor.  
Inside the sensor window, click on the ON button (  ). Then select Note On in the Midi Map 
section and Channel 1 (figure 10). 

 

 
 

figure 10 
 

STEP 7 
Quit the I-CubeX editor application.  
 
STEP 8 
Start your Reason application once again. Open the file that was previously saved as our initial 
start up setup. (see STEP 3) 

 
STEP 9 
Connect a sensor to the input port #1 of the Digitizer. Let say that we use a touch on sensor (it 
can be any sensor of your choice in fact). If everything was done carefully, you should start 
playing with your sensor. You should ear some strange noise coming out as you play with your 
sensor !!! Please note that you should see in the Reason application the following information 
shown on the screen as an indicator that your setup is good: 
 
1- Moving vertical green progress bar next to thr Subtractor row of the sequencer (see figure 

11) 
2- Blinking red led next to Note On in the Subtrator device (see figure 12) 
3- Moving vertical green progress bar next to the slider of the Subtractor (see figure 13). 
 

 
figure 11  

figure 12  
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figure 13 
EXTERNAL CONTROL OF REASON SOFTWARE WITH THE I-CUBEX 
 
 

As mentionned previously in this document, there are several ways to use MIDI with Reason. In 
the previous section, we looked at using the Digitizer with Reason sequencer. In this section, we 
focus on externally controlling Reason knobs, switches, sliders, etc… There are two ways of 
doing this. One is called direct MIDI control and the other is called remote MIDI control. The 
former uses a predefined set of MIDI control or note messages which respectively maps to a 
Reason specific slider, knob or switch of a particular device hence allowing an external MIDI 
device to control these sliders, knobs, switches, etc… (see MIDI Implementation Charts.pdf 
document). The later  
requires you to define which MIDI message to use for a certain control. In other words, it allows 
you to map any MIDI control or note message to any control on the front panel. For the purpose 
of the demonstration, we will work with the ReDrum device. 
 
 
Direct MIDI Control 
 
STEP 1 
Let say we wish to control the velocity knob (associated with the Level knob) of the drum program 
number #1 of th ReDrum (figure 14). 
 

 
figure 14 

 
 
 
The way to do this with an external control is to first look at the document named MIDI 
Implementation Charts.pdf (you should find this document in the Reason directory). Open it with 
Acrobat Reader from Adobe. On page 1, the left most column mentions a MIDI control #. A few 
columns down, a column is named ReDrum. Inside that column, you have the associated Control 
number to a specific parameter or control. Now, on the 67th row we find “Drum 1 Vel to Level” i.e. 
Control 67 is for the velocity knob associated with the level.  
 
STEP 2 

 
Start your I-CubeX editor application (we assume that your Reason application is closed). From 
the File menu of the I-CubeX editor, select New so that the Digitizer is properly resetted.  
 
STEP 3 
From the Configure menu, select Add sensor in order to create a virtual sensor.  
Inside the sensor window, click on the ON button (  ). Then select Control Change in the 
Midi Map section; Channel is 1 and Control # is 67 (figure 15). 
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figure 15 

 
 
STEP 4 
Quit the I-CubeX editor application.  
 
 
STEP 5 
Start your Reason application. Add a Redrum device from the “Create” menu. 

 
 

STEP 6 
 
On the top of the rack, there is a device names “MIDI IN DEVICE”. You should select a BUS (A in 
this case). You should have a MIDI port set to this bus (see Configure MIDI with Reason section 
if it is not the case). Then in Channel 1 window, click on the down arrow button and select the 
ReDrum device (the name of the device depends on you; in this case of the figure, the name is 
Drums).  
 

 
figure 16 

 
STEP 7 
Connect a sensor to the input port #1 of the Digitizer. Let say that we use a turn sensor (it can be 
any sensor of your choice in fact). Scroll down your window to the ReDrum device. You should 
start playing with your sensor. If everything was done carefully, you should see your velocity knob 
move according to your turn sensor. (Nota Bene: In your MIDI IN DEVICE window, you should 
also see the red indicator associated with Channel 1 (Drums In) flash as you play with your 
sensor).  
 
 
Remote MIDI Control 
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STEP 1 
Let say we wish to control the velocity knob (associated with the Level knob) of the drum program 
number #1 of th ReDrum (figure 14). 
 

 
The way to do this with Remote MIDI Control is to right click on the knob. A popup menu will 
appear as shown in figure 17. Select “Edit MIDI Remote Mapping”. The MIDI Remote dialog will 
show up as in figure 18. 
 
 

 
figure 17 

 
figure 18 

 
 
STEP 2 

 
 

umber. Click OK once you are done. Save your setup in a file and close the Reason application. 

STEP 3 
 

rom the File menu of the I-CubeX editor, select New so 
at the Digitizer is properly resetted.  

As you can see, the end-user can select either a control or a note message to control the specific
knob. (Nota Bene: Note message only works for switches). From here two options are available 
for you. You can specify the control number you wish to assign to control this knob or you simply 
click on the “Learn from MIDI Input” checkbox in order to get the appropriate MIDI message you 
wish to map. Proceed. In the former case, you have to specify the channel number and to Control 
n
 

Start your I-CubeX editor application. F
th
 
STEP 4 
From the Configure menu, select Add sensor in order to create a virtual sensor.  
Inside the sensor window, click on the ON button (  ). Then select Control Change in the 
Midi Map section; Channel is 1 and Control # is 15 (this is an arbitrary number after all) (figure 
19). 

 

 
figure 19 
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STEP 5 
Quit the I-CubeX editor application.  

Start your Reason application. Open the file you previously saved.  
 

e 

ob 
 assume that you properly configure your 

IDI. See configuring MIDI with Reason software).  

 

 

 
 
STEP 6 

STEP 7 
Connect a sensor to the input port #1 of the Digitizer. Let say that we use a turn sensor (it can b
any sensor of your choice in fact). Scroll down your window to the ReDrum device. You should 
start playing with your sensor. If everything was done carefully, you should see your velocity kn
move according to your turn sensor. (Nota Bene: We
M
 
 

 
 

 
Waiver of Liability 

 . offers no warranty, 

 OST 
 

USION SYSTEMS LTD. HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. 

  

 
This document is subject to change without notice. Infusion Systems Ltd
limited or otherwise, on any of its products and associated documents. 
UNDER NO CIRCUMSTANCES WILL INFUSION SYSTEMS LTD. BE LIABLE FOR ANY L
PROFITS, LOST SAVINGS, ANY INCIDENTAL DAMAGES, OR ANY CONSEQUENTIAL
DAMAGES ARISING OUT OF  THE USE OR INABILITY TO USE THE PRODUCT AND 
ASSOCIATED DOCUMENTS, EVEN IF INF
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